4-14-2019

Analysis of Human Mitochondrial DNA Content by Southern Blotting and Nonradioactive Probe Hybridization.

Joel H Wheeler
Carolyn K J Young
Matthew J Young

Follow this and additional works at: https://opensiuc.lib.siu.edu/bmb_articles
This is the peer reviewed version of the article cited below, which has been published in final form at Current Protocols in Toxicology. This article may be used for non-commercial purposes in accordance with Wiley Terms and Conditions for Self-Archiving.

Recommended Citation

This Article is brought to you for free and open access by the Biochemistry & Molecular Biology at OpenSIUC. It has been accepted for inclusion in Articles by an authorized administrator of OpenSIUC. For more information, please contact opensiuc@lib.siu.edu.
Analysis of human mitochondrial DNA content by Southern blot and non-radioactive probe hybridization

A Southern blot and non-radioactive probe hybridization method to estimate human mitochondrial DNA content

Joel H. Wheeler¹,², Carolyn K. J. Young,¹,³ and Matthew J. Young¹,*

¹Department of Biochemistry and Molecular Biology, Southern Illinois University School of Medicine, Carbondale, Illinois 62901

²joel.wheeler@siu.edu
³carolyn.young@siu.edu
*Correspondence to matthew.young@siu.edu

Significance Statement

A single human cell can contain several thousand copies of the maternally inherited mitochondrial DNA genome or mtDNA. Genetic disorders or exposure to certain drugs can lead to alterations in mtDNA maintenance such as mtDNA depletion. Southern blotting is a robust method to analyze mtDNA content in genomic DNA samples. Additionally, Southern blotting has been utilized to identify mtDNA deletions and duplications in samples derived from patients with mitochondrial disease. Here we describe a straightforward Southern blot and non-radioactive probe hybridization method to analyze mtDNA content in human genomic DNA samples.

ABSTRACT

A single cell can contain several thousand copies of the mitochondrial DNA genome or mtDNA. Tools for assessing mtDNA content are necessary for clinical and toxicological research as mtDNA depletion is linked to genetic disease and drug toxicity. For instance, mtDNA depletion syndromes are typically fatal childhood disorders that are characterized by severe declines in mtDNA content in affected tissues. In other circumstances, mitochondrial toxicity and mtDNA depletion have been reported in human immunodeficiency virus-infected patients treated with certain nucleoside reverse transcriptase inhibitors. Further, cell culture studies have demonstrated that exposure to oxidative stress stimulates mtDNA degradation. Here we outline a Southern blot and non-radioactive digoxigenin-labeled probe hybridization method to estimate mtDNA content in human genomic DNA samples.

Keywords: Drug-induced mitochondrial toxicity; mitochondrial DNA (mtDNA) depletion; Southern blotting; digoxigenin-labeling of DNA probes; immunodetection

INTRODUCTION
A single human cell can contain several thousand copies of mitochondrial DNA (mtDNA) that are distributed within hundreds of individual mitochondria or throughout an elaborate mitochondrial reticular network (Archer, 2013; Miller, Rosenfeldt, Zhang, Linnane, & Nagley, 2003; Spelbrink, 2010; M. J. Young, Humble, DeBalsi, Sun, & Copeland, 2015). The human mtDNA genome is a 16,569 base pair (bp) covalently closed circular molecule that contains 13 genes for polypeptides, 2 genes for rRNAs, and 22 genes for tRNAs (Fig. 1 A). Our maternally inherited mtDNA genome is critical to cellular viability as exemplified by the numerous disease mutations associated with it and by observations that knocking out mtDNA maintenance genes results in embryonic lethality in various mouse models (Humble et al., 2013; Park & Larsson, 2011). Maintenance of the mitochondrial genome is also required to avoid apoptosis induced by mtDNA damage (Santos, Hunakova, Chen, Bortner, & Van Houten, 2003; Tann et al., 2011). MtDNA can exist within a cell as a mixed population of both wild-type (WT) and mutant or deleted molecules. The proportion of WT to deleted mtDNA molecules can vary in different tissues and is an important factor in the expression of mitochondrial disease phenotypes (Goldstein & Falk, 1993). MtDNA deletions associated with mitochondrial disorders can occur as multiple large-scale mtDNA deletions or as a single ~1 to 10 kilobase pair deletion. Furthermore, levels of mtDNA deletions increase in several tissues with age (Kauppila, Kauppila, & Larsson, 2017). MtDNA depletion syndromes are characterized by severe declines in mtDNA content in affected tissues and may arise due to defects in genes encoding for mtDNA replication machinery (e.g., POLG, Alpers-Huttenlocher syndrome) or enzymes required for nucleotide synthesis (e.g., TK2). Clinical manifestations of mtDNA depletion syndromes may include myopathy, encephalomyopathy, neurogastrointestinal, or hepatocerebral phenotypes (Stiles et al., 2016). MtDNA depletion syndromes are typically recessively inherited disorders with an early-onset in infancy and early death (Finsterer & Ahting, 2013).

Evidence supports that mitochondria are targeted by environmental toxicants that disrupt mtDNA maintenance and chemical exposures can cause both increased and decreased mtDNA copy number (Meyer et al., 2013). MtDNA depletion can be a side effect in human immunodeficiency virus (HIV)-infected subjects treated with nucleoside reverse transcriptase inhibitors, NRTIs (M. J. Young, 2017). Mitochondrial toxicity from NRTIs mimics phenotypes of mitochondrial disease such as mitochondrial myopathy or other clinical manifestations (Koczor & Lewis, 2010). Also, in human cell culture studies, exposure to hydrogen peroxide stress stimulates mtDNA degradation and exposure to the oxidative metabolite 1-methyl-4-phenylpyridinium is associated with mtDNA depletion (Miyako, Kai, Irie, Takeshige, & Kang, 1997; Shokolenko, Venediktova, Bochkareva, Wilson, & Alexeyev, 2009).

Studies utilizing Southern blotting have proven to be powerful tools to assess mtDNA maintenance in human cell culture and patient samples (Berglund et al., 2017; Chen & Cheng, 1992; Hayashi, Takemitsu, Goto, & Nonaka, 1994; Holt, Dunbar, & Jacobs, 1997; Kaukonen et al., 2000; Kornblum et al., 2013; Lamantela et al., 2002; Lehtinen et al., 2000; Luoma et al., 2005; Moraes et al., 1991; Moraes, Atencio, Oca-Cossio, & Diaz, 2003; Moreton et al., 2017; Peeva et al., 2018; Rocher et al., 2008; Ronchi et al., 2013; Schon, Naini, & Shanske, 2002; Shokolenko et al., 2009; Song, Wheeler, & Mathews, 2003; Tengan & Moraes, 1996; Wallace et
al., 1995) as well as in model organisms such as mice and yeast (Griffiths, Doudican, Shadel, & Doetsch, 2009; Hance, Ekstrand, & Trifunovic, 2005; Milenkovic et al., 2013; Trifunovic et al., 2004; Tyynismaa et al., 2005; Tyynismaa et al., 2004; M. J. Young, Theriault, Li, & Court, 2006). Here we describe a straightforward Southern blot and non-radioactive probe hybridization method to estimate the quantity of mtDNA in human genomic DNA samples. A preparation of genomic DNA is fragmented utilizing a restriction endonuclease (RE) and linear fragments are separated by length via one-dimensional agarose gel electrophoresis. Next, the size-separated DNA fragments are transferred from the gel and fixed to a positively charged nylon membrane. The positions of the fragments on the nylon are maintained following transfer and fixation. A target nuclear DNA (nDNA) internal control fragment, or band of interest on the blot, is detected using a non-radioactive probe that is complementary to the nDNA sequence. An image of the nDNA band is captured and then the nylon is stripped to remove the first probe and a second mtDNA-specific probe is hybridized to the blot. A second image of the mtDNA band is then captured and the areas of the bands are quantified to estimate the amount of mtDNA.

STRATEGIC PLANNING

In preparation for Southern blotting, order the required materials including the oligonucleotide primers for synthesizing DNA probes. Primers can be obtained from a commercial vendor such as Integrated DNA Technologies. Next, prepare and quantitate the concentrations of plasmid DNA templates (for probe synthesis reactions) and human genomic DNA samples. Plasmid DNA isolated from Escherichia coli can be prepared and quantitated in one day utilizing a commercial plasmid DNA miniprep kit, e.g. E.Z.N.A. Plasmid DNA Mini Kit. Likewise, genomic DNA samples can be prepared and quantitated in a single day using a commercial kit; however, generally speaking, samples prepared via kits yield less DNA than those processed using a whole-cell DNA extraction method (see Understanding Results). If performing whole-cell DNA extraction allow an extra day for sample processing. Prepare autoclaved water, buffers, and solutions ahead of time so that all reagents are ready the day of blotting and the day of immunodetection. Finally, measure the required gel dimensions for cutting the Whatman papers, the paper towels, and the nylon. Cut these supplies in preparation to build the capillary transfer assembly.

BASIC PROTOCOL 1

Synthesis of digoxigenin (DIG)-labeled nDNA and mtDNA probes

This protocol outlines the synthesis of a digoxigenin (DIG)-labeled probe. The probe is required for hybridization and detection of a target DNA fragment on a Southern blot. DIG-labeled probes are sensitive and can be utilized as an alternative to traditional phosphorus-32 (32P)-labeled probes (Lai, Wright, & Shay, 2016). DIG-11-dUTP is a modified alkali-labile nucleotide that is incorporated into a probe by a DNA polymerase enzyme during the probe synthesis reaction. DIG-labeled probes are detected via an enzyme-linked immunoassay. Both nDNA and mtDNA probes are synthesized separately using their respective plasmid DNA templates. Plasmid template sequences were confirmed via Sanger sequencing. The pCR2.1-
TOPO-18S plasmid harbors a cloned fragment of the proliferating HepaRG™ cell line (Biopredic International Saint-Grégoire, France) nuclear 18S ribosomal pseudogene 4 (RNA18SP4) from nucleotide positions 101 to 600 as previously described (Lehtinen et al., 2000). The pCR2.1-TOPO-mtDNA plasmid harbors a cloned fragment of the human HEK-293 (ATCC® CRL-1573™) mtDNA sequence from nucleotide positions 168 to 604. The pCR2.1-TOPO-mtDNA insert differs from the NC_012920.1 reference sequence at three positions, 263 A>G, 309_310insC, and 315_316insC. These changes are identical to nucleotide positions 168 to 606 of the Homo sapiens haplogroup T2b9 mitochondrial genome, MK175431.1. The Basic Local Alignment Search Tool (BLAST) was utilized to confirm that the cloned mtDNA fragment has minimal homology to the nuclear genome (https://blast.ncbi.nlm.nih.gov/Blast.cgi). Confirmation of minimal homology between the mtDNA template and the nuclear genome is necessary to avoid probe hybridization with the previously identified mtDNA pseudogene sequences or NUMTs (Mishmar, Ruiz-Pesini, Brandon, & Wallace, 2004). Specificity of the probe for the target mtDNA genome is supported by RE digestion mapping and Southern blotting (see Fig. 1 and Table 1).

*Table 1 near here.*

**Materials**

PCR DIG Probe Synthesis Kit (Roche) containing the Expand High Fidelity enzyme mix (3.5 U/μl), 10x PCR DIG probe synthesis mix, 10x PCR buffer with 15 mM MgCl₂, and 10x dNTP stock solution.

100 pg plasmid DNA template per reaction (pCR2.1-TOPO-mtDNA or pCR2.1-TOPO-18S)

5 μM of each of the forward and reverse primers for mtDNA, mt168F TACGTTCAATATTACAGGCGAAC and mt604R TTGCTTTGAGGAGGTAAGCTAC and for nDNA, 18SF TACCTGTTGTATCCCTGCCAG and 18SR TCGGGAGTGGGTAATTTGC (Integrated DNA Technologies).

Qubit Fluorometer (ThermoFisher Scientific) to estimate DNA concentration. Alternatively, DNA concentration can be estimated using absorption spectroscopy to determine the 260nm/280nm ratio. Devices such as the Take3 Micro-Volume Plate in conjunction with the Synergy H1 microplate reader (BioTek) or the NanoDrop™ Spectrophotometer (ThermoFisher Scientific) can be used to determine 260nm/280nm.

Digital gel/blot imaging system capable of high-resolution imaging of ethidium bromide-stained gels and chemiluminescent blots (e.g., Syngene G:Box Chemi XX9 with 9.0 megapixel, 16 bit, ultra cooled CCD camera)

Thermal cycler (e.g., Applied Biosystems 2720)

Microcentrifuge (e.g., Micro-12™, EKF Diagnostics for life)

Sterile RNase, DNase-free microcentrifuge tubes

Thin-walled PCR tubes
Micropipettes and tips

Agarose gel electrophoresis apparatus (e.g., Thermo Scientific Owl Easycast B1)

Tris-acetate-EDTA (TAE) buffer (40 mM Tris, 20 mM acetate, 1 mM EDTA)

Agarose (e.g., MidSci)

DNA molecular weight marker (e.g., exACTGene 1kb Plus DNA Ladder, Fisher BioReagents)

Ethidium bromide in TAE (0.5 μg/ml), store protected from light in a cupboard

Sterile water, autoclave Milli-Q, store at room temperature

Prehybridization solution (see recipe below in Reagents and Solutions)

Sterile polypropylene conical centrifuge tubes (e.g., Santa Cruz Biotechnology)

1. Estimate plasmid template concentration by Qubit Fluorometer according to the manufacturers’ protocol.

2. Assemble the 18S nDNA DIG-labeled probe synthesis reaction. Place a sterile thin-walled PCR tube on ice and add the following components in order: PCR-grade water, 5 μl of 10x PCR buffer with 15 mM MgCl₂, 5 μl of 10x PCR DIG probe synthesis mix (dATP, dCTP, dGTP, 2 mM each, 1.3 mM dTTP, 0.7 mM alkali-labile DIG-11-dUTP), 5 μl of each of the 18SF and 18SR primers (5 μM each), 0.75 μl of enzyme mix (3.5 U/μl), and 100 pg of the pCR2.1-TOPO-18S template in a total volume of 50 μl. Mix contents and centrifuge briefly.

In a separate PCR tube assemble the mtDNA DIG-labeled probe synthesis reaction. Assemble the reaction as described above but substitute the template with pCR2.1-TOPO-mtDNA, the primers with the mt168F and mt604 primer set, and the final concentration of 70 μM DIG-dUTP with 35 μM. To obtain 0.35 mM DIG-dUTP mix equal parts of the 10x PCR DIG probe synthesis mix with 10x dNTP stock solution containing 2 mM of each of dATP, dCTP, dGTP, and dTTP.

For each primer pair assemble unlabeled control reactions by substituting 5 μl of the 10x PCR DIG probe synthesis mix, or 0.35 mM DIG-dUTP, with 5 μl of the 10x dNTP stock solution.

3. Program and run the Thermal cycler: denaturation for 2 minutes at 95°C followed by 32 cycles of PCR with 30 seconds of denaturation at 95°C, annealing for 30 seconds at 60°C, and extension for 40 seconds at 72°C. Conduct a final extension at 72°C for 4 minutes.

4. Confirm synthesis of the DIG-labeled PCR product by running 2μl of a sample on a 1.2% agarose gel alongside an unlabeled control reaction. Stain the gel by submerging in an ethidium bromide bath and mix on an orbital shaker at 50 rpm for 15 minutes. Briefly rinse the gel in sterile water then capture an image of the gel using a digital gel imaging system. The presence of DIG slows down DNA migration through the gel during electrophoresis; therefore, an upshift of the labeled product compared to an unlabeled control confirms probe synthesis (Fig.'s 1 and 2).
5. Heat denature the double-stranded DIG-labeled probe by boiling for 5 minutes in a water bath then rapidly cool by placing on ice.

6. Prepare the hybridization mixture by adding \( 2 \mu l \) of the heat-denatured probe per milliliter of prehybridization solution pre-heated to 50°C. Gently mix the solution to avoid bubble formation. For hybridization of the probe to the target DNA sequence, use the hybridization mixture at 6 ml/100 cm\(^2\) membrane as described below or aliquot and store at -20°C in 15 ml polypropylene conical centrifuge tubes.

*Following the first use of a hybridization mixture, freeze the solution at -20°C and it can be re-used twice. To re-use the mixture, thaw at room temperature, incubated in a 68°C water bath for 10 minutes, then proceed with the hybridization step below.*

**BASIC PROTOCOL 2**

**Restriction endonuclease digestion of genomic DNA and agarose gel electrophoresis**

Human cell culture genomic DNA samples for RE digestion are prepared from DPBS-washed cell pellets utilizing a commercial DNA extraction kit according to the manufacturers' protocol or utilizing an in-house whole-cell DNA extraction method (for an example see Kolesar, Wang, Taguchi, Chou, & Kaufman, 2013). Genomic DNA concentration is estimated using a Qubit Fluorometer as described in Basic Protocol 1. Next, 1 \( \mu g \) of each genomic DNA sample of interest is digested utilizing a restriction enzyme and DNA fragments are separated by agarose gel electrophoresis. To estimate mtDNA content, use an enzyme that cuts the \( \sim 16.6 \) kb covalently closed circular mtDNA genome once to linearize and visualize the entire mtDNA genome. Additionally, the restriction enzyme of choice should cut the nDNA locus such that a discernible lower molecular weight band can be achieved. Restriction mapping of both mtDNA and nDNA loci can be conducted to evaluate various enzymes. The covalently closed circular mtDNA genome contains a single BamHI cut site; therefore, digestion with this enzyme will generate a single \( \sim 16.6 \) kb linear double-stranded fragment that is detectable with the mtDNA-specific DIG-labeled probe (Fig. 1). BamHI digestion of nDNA generates a linear DNA fragment of \( \sim 2.2 \) kb that is detected with the 18S nDNA-specific probe (Fig. 2). Utilizing this approach mtDNA content can be estimated in samples of human genomic DNA digested with BamHI (see Understanding Results below).

**Materials**

- Genomic DNA samples
- BamHI restriction endonuclease (Thermo Scientific)
- Blue Juice Loading Buffer (65% w/v sucrose, 10 mM Tris-HCl pH 7.5, 10 mM EDTA, 0.015% bromophenol blue)
- Lambda DNA/HindIII Marker, 2 (Thermo Scientific)
1. Digest 1 µg of genomic DNA with BamHI. Assemble the following components in a microcentrifuge tube on ice: 1 µg of genomic DNA preparation, 2 µl of 10x buffer, 0.5 µl of BamHI (10 U/µl), and sterile water up to 20 µl. Mix and briefly spin down the RE digestion reaction. Incubate the reaction in a 37°C water bath for 3 hours.

2. Add 6.7 µl of Blue Juice to each restriction digestion reaction, mix, and briefly spin down. Load samples onto a 1% agarose gel along with a suitable DNA molecular weight marker/standard.

If the DNA has been stored at 4°C heat to 56°C for 2-3 minutes to disrupt base pairing between cohesive ends. For analysis of the human mtDNA genome, it is desirable to utilize a DNA molecular weight marker containing a band greater than the 16.6 kb mtDNA. The Lambda DNA/HindIII Marker, 2 harbors a 23.1 kb fragment. Alternatively, for immunodetected restriction fragment lengths less than 10 kb the exACTGene™ 1kb Plus DNA ladder can be used. Load DNA markers on the outside wells of the gel.

3. Apply a voltage of 1.35 V/cm, as measured between the electrodes, and run the gel for 16 hours.

**BASIC PROTOCOL 3**

**Assemble the Southern blot**

Southern blotting is the process of transferring DNA molecules from an agarose gel to a surface such as a positively charged nylon transfer membrane (Southern, 1975). The gel is first exposed to a weak acid to partially depurinate and cleave the DNA molecules into smaller fragments to allow for increased transfer efficiency of long molecules such as linearized mtDNA. Subsequently, the gel is treated with a strong base to denature double-stranded DNA into single-stranded molecules. DNA target sequences must be denatured to allow for probe hybridization and detection. Utilizing an upward capillary transfer assembly, DNA molecules shift from the gel to the nylon in a high-salt buffer (Fig. 3). The high-salt conditions allow for DNA molecules to bind to the nylon. Following DNA binding the samples are covalently fixed to the blot using UV irradiation such that the blot harbors a reproducible pattern of the gel's DNA fragments.

[*Figure 3 near here.]

**Materials**

0.25 N HCl, do not autoclave, store at room temperature for up to 1 month

Denaturing solution (0.5 N NaOH, 1.5 M NaCl), do not autoclave, store at room temperature for up to 3 months

Neutralizing solution (0.5 M Tris-HCl, pH 7.5, 3 M NaCl), autoclave, store at room temperature
20x SSC (3 M NaCl, 0.3 M sodium citrate, pH 7.0), autoclave, dilute 1 in 10 in sterile water to make 2x SSC and 1 in 40 to make 0.5 x SSC

Whatman 3MM blotting paper (GE Healthcare Life Sciences)

Hybond-N+ positively charged nylon membrane (GE Healthcare Life Sciences)

Paper towels

UV transilluminator (e.g., Fotodyne Incorporated)

Orbital shaker (e.g., BT Lab Systems)

A clean test tube

Note: All steps are carried out at room temperature wearing powder-free nitrile gloves.

1. Stain the gel in ethidium bromide as described above. Using a digital gel imaging system capture an image of the gel next to a fluorescent ruler and save the file.

   *Line up the zero millimeter mark of the ruler with the center of the gel wells. Using the ruler, measure the distance traveled in millimeters for each band of the molecular weight marker(s). Next, perform linear regression by plotting the log10 base pair values of the DNA molecular weight marker bands versus the distance traveled in millimeters. Use this standard curve to estimate the length of the immunodetected fragments on the blot, see Southern blot image acquisition and data collection with Fiji below.*

2. Destain the gel by submerging in sterile water and mixing on an orbital shaker at 50 rpm for 15 minutes. Pour off the water and repeat the destaining.

3. Partially depurinate the DNA in the gel by submerging and mixing the gel in 0.25 M HCl for 5 minutes. Rinse the gel with sterile water.

4. Submerge and mix the gel twice in denaturing solution for 15 minutes. Rinse the gel with sterile water.

5. Submerge and mix the gel twice in neutralizing solution for 15 minutes.

6. Submerge and mix the gel in sterile water for 1 minute. Cut off a small piece of the top left-hand corner of the gel to orient the location of samples loaded onto the gel.

7. Cut the Whatman paper 'wick' 1 mm larger than the gel's width and long enough that it touches the bottom of the reservoir. Cut the nylon about 1 mm larger than the gel's length and width and then cut one corner to match the left-hand corner of the gel. Cut the Whatman papers to be placed on top of the nylon the same size as the gel then cut the paper towels about 1 mm smaller than the gel's length and width (Fig. 3).

8. Immerse the hybond-N+ membrane in 2x SSC for 1 minute and briefly wet the Whatman wick in 20x SSC. Place the wick on top of a support and angle both ends of the paper into the 20x SSC
transfer buffer located within the reservoir. Roll a test tube over the wick papers to remove any air bubbles then place the gel well side down on top of the wick.

*Use an inverted gel-casting tray and a glass-baking dish as a support and as a reservoir respectively.*

9. Place the wet nylon on top of the gel such that the cut corners align.  

*Ensure air bubbles do not get trapped between the nylon and the gel and do not move the nylon once it has been placed down onto the gel.*

10. Wet the gel-sized Whatman papers in 2x SSC and then place them on top of the nylon. Smooth out air bubbles by rolling a test tube over the papers then place an ~5 cm high stack of paper towels on top of the Whatman papers.

11. Place an ~200-gram weight on top of the paper towel stack and allow the upward capillary transfer to proceed overnight for 12 to 18 hours.

12. The next day, remove the weight and discard the paper towels and gel-sized Whatman papers. Turn over the nylon, gel, and Whatman wick papers and lay them with the gel wells side up on a large dry sheet of Whatman paper. Carefully remove the 'wick' papers and then mark the position of the well slots on the nylon with a lead pencil. Carefully remove the gel from the nylon and discard it.

*To ensure proper measurements are made for RE mapping, the corners of the gel can also be marked on the nylon with a lead pencil.*

13. Fix the DNA to the nylon by exposing DNA-side down to a transilluminator for 2 minutes.

*Use appropriate safety mask and shielding to protect yourself from ultraviolet radiation.*

14. Rinse the nylon briefly in sterile water and allow it to air-dry on Whatman paper for ~15 minutes. Proceed with pre-hybridization or store the dry blot sandwiched between two dry sheets of Whatman paper then place inside an envelope and store in a drawer.

**BASIC PROTOCOL 4**

**Probe hybridization and immunodetection of target DNA fragments immobilized on the blot**

Factors to consider for annealing of the probe to the target DNA sequence are melting temperature ($T_m$), stringency washes, and incubation times. The conditions described here are optimized for the 18S nDNA- and the mtDNA-specific DIG-labeled DNA probes. If utilizing other probes or reagents from other manufacturers these factors will need to be evaluated empirically. The $T_m$ for DIG-labeled probes can be estimated from the following equation:

$$T_m = 49.82 + 0.41 \times (% G + C) - (600/l)$$
Where l = the length of the hybrid in base pairs. The actual optimal temperature for hybridization \( T_{\text{opt}} \) is equal to \( T_m \) minus 20 to 25°C.

Stringency washes represent a combination of varied salt and temperature conditions. The salt concentrations and optimal temperatures can be evaluated in preliminary experiments utilizing blots (or strips of blots) containing test samples. Various stringency washes and incubation times can then be evaluated. Following blot washing, immunological detection is conducted utilizing an anti-DIG antibody Fab fragment (antigen-binding fragment) that is coupled to alkaline phosphatase (AP), anti-DIG-AP. The chemiluminescent AP substrate CDP-Star is applied to the blot and light emission is recorded on a luminescent digital imaging system thus detecting the probe-bound target sequence as a luminescent band on the blot.

Do not allow the nylon to dry during the prehybridization through probe-hybrid visualization as this can cause high background.

**Materials**

Hybridization oven (e.g., UVP HB-1000 Hybridizer)

Borosilicate glass hybridization bottles (35 x 150 mm)

2x SSC + 0.1% SDS (see recipe below in Reagents and Solutions)

0.5x SSC + 0.1% SDS (see recipe below in Reagents and Solutions)

Maleic acid buffer (see recipe below in Reagents and Solutions)

Maleic acid buffer + 0.3% Tween™ 20 + 0.015% SDS (see recipe below in Reagents and Solutions)

Blocking buffer + 0.015% SDS (see recipe below in Reagents and Solutions)

Sheep anti-DIG-AP conjugated Fab fragments, 750 U/ml (Roche)

Detection buffer (0.1 M Tris-HCl, 0.1 M NaCl, pH 9.5)

CDP-Star chemiluminescent substrate for AP, 25 mM (Roche)

**Prehybridization and hybridization of the DIG-labeled probe**

1. Turn on and prewarm the hybridization oven to 50°C. Use 6.0 ml pre-warmed prehybridization solution per 100-cm² nylon membrane. Carefully place the nylon membrane into a hybridization bottle with the DNA-side facing inward. Place the hybridization bottle onto the hybridization oven rotary wheel carousel. Balance the hybridization bottle with a second bottle filled with water if only one blot is being processed. Pre-hybridize the blot at maximum rpm for 2-3 hours at 50°C.
2. Decant the prehybridization solution from the hybridization bottle and add 6 ml per 100-cm² nylon membrane of pre-warmed hybridization mixture containing the 18S DIG-labeled probe. Hybridize at 50°C for 12 to 16 hours with the rpm set to maximum.

*If using the mtDNA-specific DIG-labeled probe the hybridization temperature remains the same, 50°C. To prevent irregular background patterns, do not let the membrane dry between solution transfers and do not allow bubbles to form between the membrane and the hybridization bottle.*

**Stringency washes**

3. Remove the hybridization mixture from the hybridization bottle and store at -20°C in a 15 ml polypropylene conical tube. Next, turn off the heat for the hybridization oven then add an equal volume of room temperature 2x SSC + 0.1% SDS to the bottle and place back into the oven. With rpm set at maximum, turn on the rotary wheel carousel and allow the blot to wash for 5 minutes with the door open and heat off.

*The probe can be re-used two more times when freshly denatured at 68°C for 10 minutes before use. Do not boil the hybridization mixture.*

4. Remove the hybridization bottle and decant the 2x SSC + 0.1% SDS. Repeat the 2x SSC + 0.1% SDS wash with the heat off and door open.

5. Wash the blot twice for 15 minutes with prewarmed 0.5x SSC + 0.1% SDS with the hybridization oven door closed and temperature set to 65°C.

*If preparing and freezing blocking buffer ahead of time, thaw an aliquot at this stage (see recipe below in Reagents and Solutions).*

6. Move the blot from the hybridization bottle to a polystyrene blotting container/box. Equilibrate the membrane in enough maleic acid buffer to completely cover the blot and mix for 2 minutes on an orbital shaker set at 50 rpm. Decant the buffer, add blocking buffer + 0.015% SDS, and mix for 30 minutes.

**Immunodetection of the target DNA sequence utilizing anti-DIG-AP and CDP-Star**

7. Dilute the anti-DIG-AP in the blocking buffer + 0.015% SDS, which contains the blot, to 75 mU/ml (1 in 10,000) and incubate with mixing for 1 hour. Decant the anti-DIG-AP solution and rinse the blot three times with sterile water.

8. Wash the blot twice with maleic acid buffer + 0.3% Tween 20 + 0.015% SDS for 15 minutes with shaking. Rinse the blot with sterile water between washes. Equilibrate the blot for 3 minutes in detection buffer with mixing.

9. Dilute the CDP-Star substrate to 0.25 mM in detection buffer. Place the blot on a piece of plastic wrap, DNA side facing up. Gently apply 1 ml of 0.25 mM CDP-Star evenly to the surface of the blot using a micropipette. Lifting the corners of the plastic wrap, allow the substrate to distribute over the face of the blot for ~1 minute. Transfer the blot to a fresh piece of plastic wrap.
wrap large enough to fold over the blot without air bubbles then incubate for 5 minutes at 37°C.

Allow the excess CDP-Star to drip onto a lint-free laboratory wipe prior to folding between the plastic wrap. Work quickly as to not let the blot dry out. CDP-Star leaking behind the nylon and plastic wrap can cause the blot to stick to the surface of the gel-imaging device during image acquisition.

**BASIC PROTOCOL 5**

**Southern blot image acquisition and data collection with Fiji**

Fiji is an open source image-processing package available from http://fiji.sc/. Fiji is based on ImageJ and provides many bundled plugins.

**Materials**

Download and install Fiji from http://fiji.sc/ on to a computer.

1. Line up the zero millimeter mark of a fluorescent ruler with the center of the gel well markings on the blot. Utilizing an imaging system capable of capturing luminescence signals from Southern blots, save a high-resolution grayscale TIFF image of the blot (600 dpi). Also, save a second visible image of the ruler next to the blot.

   If an auto-capture option is available (e.g., Chemi Capture in GeneSys for the Syngene G:Box Chemi XX9) use this setting to capture the maximum available grayscales of the blot and to prevent image saturation. In GeneSys, select the 'Visible marker' box to image the ruler. If utilizing a manual capture option, ensure the show saturation setting is turned on as to not over-expose the image. Saturated images cannot be quantified. Measure the distance traveled in millimeters for each immunodetected band. Next, using these migration distances and the standard curve described above in 'Assembling the Southern blot' estimate the base pair length of each fragment.

2. Open the TIFF file in Fiji. If necessary, the image can be rotated by clicking on the Image menu command > Transform > Rotate.

   Checking the Preview box will allow you to view the rotation before changing the image. The number of gridlines can be adjusted by simply typing in the desired number. The degree of rotation can be increased or decreased by one-degree increments using the angle slider or can be typed into the angle box.

3. Using the Rectangular Selection Tool on the Toolbar, select the first lane making sure to draw the rectangle as close to the sides of the band as possible. The profile plot that is generated will allow measurement of the band (peak) area (Figure 4).

   Draw a long rectangle down the length of each lane to visualize both the area of the band and the blot background.
4. Select Gels from the Analyze drop down menu then click on Select First Lane. The number 1 should appear in the center of the rectangle.

5. Click anywhere inside the first rectangle and drag to create a second rectangle of equal dimensions. Use the second rectangle to select the second lane to be analyzed. Again the sides of the rectangle should be just big enough to fit the entire band. Choose Analyze > Gels > Select Next Lane. The number 2 will appear inside the second rectangle. Repeat this step until all desired lanes have been selected.

6. Choose Analyze > Gels > Plot Lanes. This will generate a plot profile of each lane. Using the Straight Line Selection Tool, draw baselines such that each peak of interest is defined as a closed area, i.e. close off the bottom of the peaks corresponding to the desired bands by drawing a line connecting the background on either side of the peak.

7. Select the Wand (tracing) tool on the Toolbar. Click the inside of each closed area peak on the plot profile to be measured. The outline of the peak should change color from black to yellow as the area is measured and area values will be reported in a results window.

   *If more of the plot is selected, then this means the peak was not completely closed off and another line will need to be drawn. Close the results window without saving the data then close off the problematic peak area on the plot profile with the Straight Line Selection Tool. Next, measure the peak areas with the Wand tool.*

8. Select Analyze > Gels > Label Peaks to report each peak area as a percentage of the total size of all measured peak areas in the Results window.

9. Copy and paste the values from the Results window into a spreadsheet program such as Microsoft Excel for further calculation.

   *For further details on utilizing Fiji refer to the user-guide.pdf available for download at https://imagej.nih.gov/ij/docs/*.

**BASIC PROTOCOL 6**

**Stripping the DIG-labeled 18S probe off the blot**

   The alkali-labile form of DIG-11-dUTP allows for easy and efficient removal of a DIG-labeled probe. Removal of the first 18S nDNA DIG-labeled probe allows for independent detection of the second mtDNA target.

**Materials**

   Stripping buffer (0.2 N NaOH, 0.1% SDS), make fresh before use

   2x SSC, dilute 20x SSC 1 in 10 in sterile water
1. Remove the blot from the plastic wrap and wash in sterile water with shaking for 1 minute at room temperature.

2. Prewarm the hybridization oven and stripping buffer to 37°C. Place the blot DNA-side facing inward into a hybridization bottle, add 6 ml of prewarmed stripping buffer, and place the bottle on the rotary wheel carousel. With the hybridization oven rotary wheel carousel rpm set to maximum, wash the blot twice in stripping buffer for 15 minutes at 37°C.

3. Wash the blot once in 2x SSC for 5 minutes at room temperature.

4. Rinse the blot in sterile water then pre-hybridize, hybridize, and immunodetect the mtDNA-specific DIG-labeled probe as described above in BASIC PROTOCOL 4.

Alternatively, store the stripped blot wet in 2x SSC at room temperature until ready to proceed with the next probe.

REAGENTS AND SOLUTIONS

Prehybridization solution (DIG Easy Hyb buffer). Pre-warm a bottle of DIG Easy Hyb Granules (Roche) and a container of autoclaved Milli-Q purified water to 37°C. Add the contents of one bottle to 64 ml of pre-warmed sterile water in a clean glass beaker and dissolve by stirring on a magnetic stirrer immediately for 5 minutes at 37°C. Once dissolved, use a portion of the solution to rinse and dissolve the remaining powder in the bottle then pool with contents in the beaker and mix for an additional minute. Unused portions of DIG Easy Hyb working solution can be aliquoted into sterile polypropylene conical centrifuge tubes and stored at -20°C. Do not boil prehybridization solution.

2x SSC + 0.1% SDS. While mixing, dilute 20x SSC 1 in 10, and 10% sodium dodecyl sulfate (SDS) 1 in 100, in sterile water. e.g., For 1 liter add 100 ml of 20x SSC to 890 ml of sterile water while mixing on a magnetic stirrer. Next, add 10 ml of 10% SDS and allow to mix until homogenous.

0.5x SSC + 0.1% SDS. Dilute 20x SSC 1 in 40 and 10% SDS 1 in 100 in sterile water while mixing.

Maleic acid buffer (0.1 M maleic acid, 0.15 M NaCl, pH 7.5). For 2 liters add 23.21 grams of maleic acid, 17.53 grams of NaCl, and ~15 grams of NaOH pellets to 1.8 liters Milli-Q water and mix until dissolved on a magnetic stirrer. Adjust pH to 7.5 with 3 M NaOH, bring the volume up to 2 liters with Milli-Q water, mix, autoclave, and store at room temperature.

Maleic acid buffer + 0.3% Tween™ 20 + 0.015% SDS. Dilute 10% Tween™ 20 (Fisher BioReagents) 1 in 33 and 10% SDS 1 in 667 into maleic acid buffer while mixing.

Blocking buffer + 0.015% SDS. Prepare the blocking buffer by diluting 10x blocking solution (Roche) 1 in 10 with maleic acid buffer. Unused portions of blocking buffer can be frozen at -20°C. Add 10% SDS just before use by diluting 1 in 667 and mix.

COMMENTARY

Background Information
Southern blotting was first described as a method for DNA fragment analysis by E. M. Southern in 1975. Southern blotting followed by probe hybridization has been a steadfast tool to study restriction fragment length polymorphisms and to detect rearrangements in immunoglobulin and T cell receptor genes (Brown, 1993). Southern blotting is one of the best-described methods for analyzing human mtDNA maintenance (Berglund et al., 2017; Chen & Cheng, 1992; Hayashi et al., 1994; Holt et al., 1997; Kaukonen et al., 2000; Kornblum et al., 2013; Lamantea et al., 2002; Lehtinen et al., 2000; Luoma et al., 2005; Moraes et al., 1991; Moraes et al., 2003; Moretton et al., 2017; Peeva et al., 2018; Rocher et al., 2008; Ronchi et al., 2013; Schon et al., 2002; Shokolenko et al., 2009; Song et al., 2003; Tengan & Moraes, 1996; Wallace et al., 1995). Skeletal muscle mtDNA deletions are associated with the mitochondrial disease progressive external ophthalmoplegia (PEO) and traditionally have been detected via Southern blot analyses (Kaukonen et al., 2000; Lamantea et al., 2002; Moraes et al., 1989; Moslemi, Melberg, Holme, & Oldfors, 1996). Additionally, duplications of mtDNA have been identified in mitochondrial myopathy patient samples using Southern hybridization (Poulton, Deadman, & Gardiner, 1989). Southern blotting has been seminal in providing insight into the mechanism of NRTI mitochondrial toxicity. For instance, HIV-positive patients treated with zidovudine and who displayed mitochondrial myopathy and ragged-red fibers were found to have severely reduced amounts of muscle mtDNA when biopsy samples were investigated by Southern blotting (Arnaudo et al., 1991). Another study investigated HIV-positive patients who developed neuropathy 6–10 weeks after starting zalcitabine and this investigation found mitochondrial alterations and significantly reduced mtDNA copy number in nerve biopsy samples (Dalakas, Semino-Mora, & Leon-Monzon, 2001). Additionally, cell culture, animal model, and biochemical studies have demonstrated that mitochondrial toxicity can result from NRTIs blocking the mtDNA replication and repair machinery (M. J. Young, 2017). Recently, Southern blotting served as a powerful tool to characterize and identify the human degradosome, the mitochondrial machinery that quickly degrades mtDNA harboring double-stranded breaks (Peeva et al., 2018). Other methods that can be used to estimate mtDNA content include competitive PCR (Dalakas et al., 2001), real-time PCR (Ashley, Harris, & Poulton, 2005), and digital-PCR (Belmonte et al., 2016).

**Critical Parameters and Troubleshooting**

The most desirable outcome in Southern blotting is to obtain blots with specific clear and intense bands of expected molecular weights (MWs) and with clear backgrounds. Care must be taken to accurately determine genomic DNA concentrations in all samples prior to setting up RE digestion reactions. If DNA concentrations are measured properly the 18S nDNA fragments in all samples loaded equivalently on the gel should have nearly identical intensities on the blot irrespective of the difference in mtDNA content (see Fig. 1’s 5 A & 6 A). But the most critical parameter in obtaining desirable blot photographs for mtDNA quantitation is the generation of highly specific and sensitive DIG-labeled probes. This step has become straightforward using the PCR DIG Probe Synthesis Kit from Roche Diagnostics GmbH. Genomic DNA can be difficult to use as a template with the DIG-labeled probe synthesis reaction. Instead, use genomic DNA fragments cloned into plasmids as templates such as the pCR2.1-TOPO-mtDNA and pCR2.1-TOPO-18S plasmids described here. Inefficient labeling of the probe
or a probe concentration that is too low can result in a low signal on the blot. For a low yield of DIG-labeled PCR product (probe), try to optimize the PCR cycling conditions in the absence of DIG-dUTP and run the PCR product on an agarose gel to confirm amplification (Fig.'s 1 and 2). To obtain sufficient amplification in the presence of the DIG-dUTP label, the concentration of DIG-dUTP may need to be reduced to a concentration as low as 7 μM depending on the template DNA GC content and sequence length. PCR-generated DIG-labeled probes do not require clean up and can be directly added to prehybridization solution after boiling.

[*Figure 5 near here.]*

[*Figure 6 near here.]*

If the background on a blot is cloudy the probe concentration may be too high. Aim to add as little as 0.5 μl probe per milliliter of hybridization mixture to correct this issue. Further, contaminated templates in PCR reactions can produce impure probes that cause cloudy backgrounds. Therefore, it may be necessary to prepare fresh plasmid template DNA. Blots with spotty backgrounds typically result from a precipitate formation in the antibody stock solution. Microcentrifuge the anti-DIG alkaline phosphatase conjugate at 10,000 rpm for 5 minutes prior to each use to remove any precipitates. Additionally, the background can be improved by the addition of 0.015% SDS to the wash buffer and the blot can be washed overnight if necessary (Li & Court, 2002). Smearing down the length of a lane can result from the use of too much template in the PCR reaction, from the probe binding to other regions in the genome other than the target sequence, or from degradation of the target sequence. Try using as low as 10 pg of plasmid DNA template, cloning a new target of interest, or re-preparing genomic DNA samples to combat these issues. Do not allow the nylon to dry during the prehybridization through immunodetection and probe stripping stages as this can cause irregular background patterns. Use at least 6 ml of hybridization solution per hybridization bottle to ensure blots stay wet. Batches of hybridization mixtures can be tested for their ability to generate clear backgrounds and strong specific signals by leaving spaces between samples loaded onto a gel, blotting, then cutting the blots into strips such that each strip contains a genomic DNA sample to be tested. Load the strips into hybridization tubes with various hybridization mixtures to be tested. Incomplete transfer of DNA during capillary transfer can result in uneven and diffuse banding patterns. Ensure DNA concentrations are accurately measured and that the weight is centered and evenly distributed during set up of the transfer pyramid (Fig 3). Also, if the weight is too heavy the gel will get crushed and the transfer will be inefficient. The efficiency of genomic DNA samples transferring to the nylon can be tested by re-staining the gel with ethidium bromide following disassembly of the pyramid. For other suggestions and important parameters related to the assembly of the capillary transfer pyramid and linking genomic DNA samples to the nylon, see Brown, 1993.

Statistical Analyses

All data presented are mean values ± standard deviations (SDs). Statistical significance between groups was determined using a Mann-Whitney U test or a Student’s t-test. P-values less than 0.05 were considered significant.
**Understanding Results**

Examples of anticipated results can be found in Fig.'s 1, 2, 5 and 6. Proliferating HepaRG (Biopredic International Saint-Grégoire, France) were grown as previously described (Gripon et al., 2002; C. K. J. Young & Young, 2019). Genomic DNA was prepared according to the E.Z.N.A. Tissue DNA Kit Cultured Cells Protocol (OMEGA bio-tek) or to the whole-cell DNA extraction method described by Kolesar et al., 2013. DIG-labeled PCR products appear as discrete bands on agarose gels that run slower than unlabeled control PCR products (Fig.'s 1 A and 2 C). Conducting RE mapping is suitable to confirm probe specificity for target sequences and to ensure reagents and equipment are in working order. Using the reagents described in this protocol, the calculated molecular weights of the RE fragmented mtDNA on a Southern blot are consistent with *in silico* predictions utilizing the mtDNA reference sequence, NC_012920.1, Fig. 1 and Table 1. Similarly, RE fragmented nDNA is consistent with *in silico* predictions made utilizing the 18S reference sequence (RNA18SP4, 18S ribosomal pseudogene 4) with the exception that if EcoRI is used a single extra high MW band in each of the EcoRI, EcoRI + SphI, and EcoRI + PstI digests is present (Fig. 2 and Table 1). Also, these extra nDNA bands were observed in Southern blots of SJCRH30 (ATCC® CRL-2061™) genomic DNA samples. SJCRH30 cells were grown according to ATCC recommendations and DPBS-washed pellets were processed using the whole-cell DNA extraction method. The 18S ribosomal DNA (rDNA) sequence is highly repetitive in the human nuclear genome and rDNA repeats comprise 600 to 800 copies per diploid human genome (Srivastava, Srivastava, & Ahn, 2016). One of the three EcoRI sites in the 18S region is polymorphic (Poly R) and resistant to cleavage (Fig. 2, Poly R site **). The polymorphic RE mapping likely results from methylation of the Poly R site as predicted CpG methylation sites are found immediately flanking this site and some combinations of methylation block EcoRI activity. In support of this hypothesis, the levels of methylation at the 18S gene have been found to be high in patients with ovarian cancer (Srivastava et al., 2016). Further complicating the nDNA mapping, the 18S rDNA sequence is highly repetitive and therefore single nucleotide polymorphisms (SNPs) at Poly EcoRI could also contribute to unexpected cleavage patterns. Sanger sequencing analysis of a PCR product generated using HepaRG template DNA, and harboring the Poly R site, confirmed a C>A polymorphism (Fig. 2 A).

Genomic DNA samples from different extraction methods can be compared side-by-side on Southern blots to estimate mtDNA content relative to nDNA content. To examine mtDNA content utilize BamHI digested genomic DNA samples as this particular endonuclease generates suitable discrete banding patterns with both DIG-labeled probes, a 16.6 kb mtDNA genome-length band and a 2.2 kb nDNA band (Fig.'s 5 & 6). Comparison of two genomic DNA extraction methods side-by-side via Southern blot produces specific signals for the mtDNA and nDNA targets; however, a decrease in mtDNA content is observed using a kit-based method as compared to the whole-cell method (Fig. 5). The nDNA signal on the blot remains unchanged between the two preparation methods as would be expected for loading 1 µg of each BamHI digested DNA sample into each lane. Thus, the 18S rDNA Southern blot bands serve as appropriate internal controls for confirming equal sample loading. Assuming the amount of cell/mitochondrial lysis is equivalent between the two methods, we hypothesized that the decrease in the kit-based yield of mtDNA content results from a greater binding affinity of
nDNA to the column. Indeed when whole-cell extracted DNA preparations are processed using the kit, and compared to the sample inputs used prior to column processing, a similar decrease in mtDNA content is observed via Southern blot (Fig. 6). These results emphasize the importance of optimizing the DNA extraction method of choice for studying mtDNA maintenance in human cell lines and for obtaining the maximum yield of mtDNA. In summary, Southern blotting provides a robust method to analyze mtDNA content from genomic DNA samples prepared by different methods. This method should prove useful for analyzing mtDNA depletion in samples exposed to various compounds or toxicants suspected of disrupting mtDNA maintenance.

**Time Considerations**

Planning a timeline is advised, as five days are required to collect all of the required images. This timeframe can be cut down to four days by pooling the two probes together in the hybridization solution; however, mixing of probes could complicate results if mtDNA degradation or deletions are expected around the region of the nDNA band. Day 1, run the digests and gel on the same day and run the gel overnight. Day 2, stain the gel in ethidium bromide, acquire a digital image, and set up the Southern blot. Day 3, pre-hybridize and hybridize the first probe to the blot. Day 4, immunodetect and acquire digital images of the blot then remove the first probe using the stripping protocol. Hybridize the second probe on Day 4 or store the stripped blot in 2x SSC with gentle mixing overnight or over the weekend at room temperature. On day 5 carry out immunodetection, acquire the second set of digital images from the blot, and analyze the results. Unlike 32P-labeled probes, which need to be used relatively quickly due to the short half-life of 32P and subsequent loss of signal strength, DIG-labeled probes can be stored for one year at -20°C. Furthermore, scientists using DIG-labeled probes do not have to be trained in the handling of radioactive materials.

**ACKNOWLEDGMENT**

This research was supported by a National Institute of Environmental Health Sciences Pathway to Independence Award to MJY (5R00ES022638-04) and by start-up funds from SIU School of Medicine. We thank Dr. Kristin Delfino for assistance with statistical analyses of data and Dr. Farid Kadyrov for scientific discussions. The work of Drs. Christiane Guguen-Guillouzo, Christian Trepo, and Philippe Gripon are acknowledged for the isolation and the characterization of HepaRG. Send requests for plasmids to matthew.young@siu.edu.

**LITERATURE CITED**


**FIGURE LEGENDS**

**Fig. 1.** Restriction endonuclease mapping of the human mtDNA genome utilizing the mtDNA-specific DIG-labeled probe. **A.** Map of mtDNA highlighting the location and position of key restriction endonuclease (RE) sites. The star represents the binding site for the probe and the 22 small triangles represent the mitochondrial tRNA genes. The remaining features on the mtDNA map going clockwise from the top of the circle include the control region (with heavy-strand origin of replication and displacement-loop), followed by genes coding for 12 S rRNA, 16 S rRNA, NADH dehydrogenase (ND) 1, ND2, cytochrome oxidase (COX) I, COXII; ATPase 8, ATPase 6, COX III, ND3, ND4L, ND4, ND5, ND6 and, cytochrome b. 

**i.** A 1.2% agarose gel with unlabeled (U) control and DIG-labeled (D) PCR products generated using the mt168F and mt604R primer set. 

**ii.** Expected kilobase pair (kb) fragment lengths following RE digestion. Numbering and RE sites are based on the 16.569 kb human reference sequence, NC_012920.1. 

**B.** A representative Southern blot of HepaRG whole-cell DNA samples separately digested with key REs. Both the exACTGene™ DNA Ladder and Lambda DNA/HindIII Marker, 2 were run alongside the samples. The migration distances of the 23.1 kb lambda fragment and the 10 to 2 kb exACTGene fragments are emphasized on the left-hand-side of the blot. S, SphI; B, BamHI; P, PstI; R, EcoRI, R + S, EcoRI & SphI; R + P, EcoRI & PstI. Note, S and B only cut once within mtDNA generating a genome length fragment.

**Fig. 2.** Restriction endonuclease mapping of the repetitive 18S rDNA loci using the nDNA-specific DIG-labeled probe. **A.** Map of the human 18S region emphasizing the location and position of important RE sites. The star indicates the probe-binding site. Three EcoRI restriction sites are emphasized with asterisks. The DNA sequences for each of the EcoRI sites are emphasized in bold text in the gray box at the top of the figure and putative CpG methylation sites are underlined. Sanger DNA sequencing of a PCR product harboring the HepaRG
polymorphic EcoRI site, Poly R site (**), revealed a minor A peak under the C peak of the EcoRI sequence (inset, upper left-hand-side). The unexpected high MW bands in each of the R, R+S, and R+P reactions likely result from a failure of EcoRI to cut at Poly R due to a combination of CpG methylation and the C>A polymorphism. Failure of EcoRI to cut at Poly R would result in 17.5 (Poly R+S), 17.8 (Poly R), and 5.5 (Poly R+P) kb bands. Mono R, the expected monomorphic or wild-type EcoRI fragment. B. A representative Southern blot of HepaRG whole-cell DNA samples digested with key REs. C. A 1.2% agarose gel with unlabeled (U) control and DIG-labeled (D) PCR products generated using the 18SF and 18SR primer set.

Fig. 3. Schematic of the Southern blot upward capillary transfer assembly.

Fig. 4. Determining relative band areas on a Southern blot. Fiji image processing for a representative mtDNA blot is shown. Samples were cut with BamHI. The lanes on the blot are selected using the Rectangular Selection Tool, 1 - 6. The closed area plot profiles of lanes 1-4 are shown to the right of the blot. The 'Area' and 'Percent' values are presented in the results window.

Fig. 5. Estimating mtDNA content in HepaRG genomic DNA samples extracted utilizing a whole-cell DNA extraction method or a commercial kit. A. Comparison of BamHI digested whole-cell and commercial kit DNA samples via Southern blotting. One microgram of each genomic DNA sample was loaded in triplicate onto a 1% agarose gel prior to blotting. The blot was initially probed with the DIG-labeled 18S nDNA probe (N, lower panel), stripped, and then re-probed with the mtDNA-specific probe (MT, upper panel). B. Relative percent of mtDNA (% mtDNA). Mean peak 'Percent' values of whole-cell (W-C) mtDNA samples were greater than those from the commercial kit DNA samples (Kit) and were set to 100%, ****, P < 0.0001. A 'Percent' value is defined as the area of a peak measured as a percentage of the total size of all measured peak areas on a blot (see Step 8 of Basic Protocol 5). C. Relative percent of 18S nDNA (% nDNA). Mean peak 'Percent' values of the Kit 18S samples were set to 100%. As would be expected for loading equal amounts of DNA in each lane, no statistically significant difference in % nDNA was observed, P = 0.8. Data are presented as mean ± SD, n = 18 from at least three independent whole-cell (W-C) and three independent commercial kit (Kit) extractions done on separate days. A total of 6 blots with each blot containing triplicate sample replicates were used for the analysis. A representative blot is shown in A.

Fig. 6. Comparison of whole-cell extracted DNA prior to and following column purification. A. Whole-cell DNA was extracted and suspended in TE + 1 mM dimethyl urea (radical scavenger), digested with BamHI, and 1 µg of each sample was loaded in triplicate onto a 1% agarose gel prior to blotting (Input). Alternatively, 20 µg of whole-cell extracted DNA was processed identically to cell pellets using the kit-based method, digested with BamHI, and 1 µg of each sample was loaded in triplicate onto a 1% agarose gel prior to blotting (Column). B. Relative percent of mtDNA (% mtDNA). Mean peak 'Percent' values of 'Input' mtDNA samples were greater than those from the 'Column' and were set to 100%, ***, P < 0.0003. A 'Percent' value is defined as described in the legend for Fig. 5. C. Relative percent of 18S nDNA (% nDNA).
Mean peak 'Percent' values of the 'Column' were set to 100%. As would be expected for loading equal amounts of DNA in each lane, no statistically significant difference in % nDNA was observed. Data are presented as mean ± SD, n = 9 from three independent whole-cell DNA extractions and from two different HepaRG passages, P9 and P13. A total of 3 blots with each blot containing triplicate sample replicates were used for the analysis. A representative blot is shown in A.
Table 1. Summary of human mtDNA and nDNA restriction endonuclease fragment sizes detected via Southern blotting with mtDNA- and nDNA-specific probes.

<table>
<thead>
<tr>
<th>Single or double digest reactions&lt;sup&gt;a&lt;/sup&gt;</th>
<th>mtDNA fragment sizes</th>
<th>nDNA fragment sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Observed molecular weight (kb)&lt;sup&gt;b&lt;/sup&gt;</td>
<td>Expected molecular weight (kb)</td>
</tr>
<tr>
<td>SphI</td>
<td>15.9 ± 0.78&lt;sup&gt;c&lt;/sup&gt;</td>
<td>16.6</td>
</tr>
<tr>
<td>BamHI</td>
<td>15.9 ± 0.78&lt;sup&gt;c&lt;/sup&gt;</td>
<td>16.6</td>
</tr>
<tr>
<td>PstI</td>
<td>15.4 ± 0.62&lt;sup&gt;c&lt;/sup&gt;</td>
<td>14.5</td>
</tr>
<tr>
<td>Mono. EcoRI</td>
<td>8.65 ± 0.57</td>
<td>8.1</td>
</tr>
<tr>
<td>Poly. EcoRI</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Mono. EcoRI + SphI</td>
<td>6.75 ± 0.10</td>
<td>6.4</td>
</tr>
<tr>
<td>Poly. EcoRI + SphI</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Mono. EcoRI + PstI</td>
<td>8.65 ± 0.57</td>
<td>8.1</td>
</tr>
<tr>
<td>Poly. EcoRI + PstI</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

<sup>a</sup> Mono. EcoRI and Poly. EcoRI, the 18S monomorphic and polymorphic EcoRI alleles respectively that are discussed in the legend to Fig. 2.

<sup>b</sup> The average values for n = 4 blots done on different days using 5 preparations of whole-cell extracted DNA are reported with errors as standard deviations.

<sup>c</sup> For SphI, BamHI, PstI, Poly. EcoRI, and Poly. EcoRI + SphI digests generating fragment lengths greater than 10 kb, restriction fragment lengths detected via Southern blotting were estimated using linear regression of the log<sub>10</sub> base pair values of Lambda DNA/HindIII Marker, 2 fragments loaded onto the same gel versus distance traveled in millimeters. For the remaining reactions generating fragments lengths less than 10 kb, the log<sub>10</sub> base pair values of exACTGene<sup>TM</sup> 1kb Plus DNA ladder fragments versus distance traveled in millimeters were utilized as standards to estimate molecular weights.

<sup>d</sup> The molecular weight of the 18S nDNA fragment cut with SphI exceeded the range of both standard curves generated utilizing either the lambda DNA HindIII fragments or the exACTGene<sup>TM</sup> ladder fragments; therefore, a calculated molecular weight is not reported for this sample. N/A, not applicable.
Fig. 1
Fig. 2
Fig. 3

Container to hold weight

~200g weight

2x Whatman papers

Paper towel stack

Hybond-N+ nylon

Agarose gel

Whatman wick

Support

20x SSC

Reservoir
Fig. 4